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This guide describes how to install and use MassHunter Mass 
Profiler Software.

Where to find more information

Use the online help for in-depth information not given in this 
Quick Start Guide. Display online help in either of the following 
ways:

• Click Contents on the MassHunter Mass Profiler Software 
Help menu.

• Press the F1 key to get more information about a window, tab, 
or dialog box.
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What is MassHunter Mass Profiler software?

MassHunter Mass Profiler software operates on the compound data of 
different samples stored in .cef (compound exchange file) format files that are 
produced by MassHunter Qualitative Analysis software. It lets you:

• Investigate similarities and differences in features across multiple 
analyses and samples. 

• Align and normalize features from different samples.

• Identify features using the MassHunter ID Browser program.

Terminology

Features Features are discrete molecular entities defined by a particular 
retention time and mass.

Samples Content imported from .cef or .csv files represent individual sample 
analyses and are called samples in MassHunter Mass Profiler software.

Groups Related samples can be grouped together for analysis. By default, the 
two groups are named “Experiment” and “Control”, but these can be changed.

Project A project is one or two sample groups considered together for 
analysis.

Method A method is all the parameters used for filtering, aligning, 
normalizing, and processing samples in MassHunter Mass Profiler software.

Processing and Viewing Results

The results of processing samples appear in the MassHunter Mass Profiler 
software main window Feature Plot and Feature Table.

Use the Feature 
Plot to:

• Investigate features using five different plot types: Mass vs. Retention Time, 
Log2 Ratio vs. Retention Time, Log/Log plot, Unique to <Group 1> and 
Unique to <Group 2>.

• Investigate features in individual or multiple samples

• Investigate features that exceed a certain visibility threshold

• Investigate features by mass and RT across all samples or use color to 
distinguish individual features or to identify features by sample or group.
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See “Feature Plot” on page 11 for more information.

Use the Feature 
Table to:

• View all the features for their summary, group statistics and differences 
between the two groups.

• View individual feature details, including species clusters found in a 
selected sample.

See “Feature Table” on page 15 for more information.

Identification

MassHunter Mass Profiler software lets you identify feature composition using 
the MassHunter ID Browser program. Features can be identified individually 
or in a batch. The identification methods available are Database search (CSV, 
PCD/METLIN) and MFG (molecular formula generation). Spectral library 
search is not currently supported in ID Browser for LC/MS data.

See “Identifying Features” on page 36 for more information. 

Exporting data

You can export data generated by MassHunter Mass Profiler software that is 
displayed in the Feature Table or Feature Plot in the following formats:

• Feature Summary data for use in Excel.

• Averaged ion data (m/z and RT of representative ions) for each feature in 
the table for use in data acquisition in targeted MS/MS experiments.

• Feature data for use in Mass Profiler Professional.

• Feature data from different samples are summed up to form a composite 
compound. This export file format can be used with the Find by Formula 
feature in MassHunter Workstation Qualitative Analysis software or as 
input to standalone ID Browser program.

See “Exporting Mass Profiler Data” on page 40 for more information.
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What’s New in Version B.03.00 SP1?

• Compatible with Windows 7 (64-bit)

• Improved retention time alignment

• Support for ID Browser B.03.01 SP4 (required for Windows 7)

Installation

If MassHunter Mass Profiler Software B.03.00 or earlier is already installed on 
your system, remove it first. See “To remove the software” below.

1 Insert the disk labeled Agilent G3297AA into the drive.
2 From the installation disk, double-click Setup.exe.

If the operating system is Windows 7, right-click Setup.exe, then select Run 
as administrator.

3 Follow the instructions on the screen to install the software.

You are prompted to enter a folder where data will be stored. The default is 
D:\MassHunter. A MassProfiler folder is created in the location you specify, 
with the following subdirectories:

• Input data

• Methods

• Projects

• Results

To remove the software

Use the Add/Remove window of the Control Panel.

Startup

To start the MassHunter Mass Profiler Software:

• Double-click the Mass Profiler icon  on the desktop, or 

• Select Programs> Agilent> MassHunter Workstation> Mass Profiler from 
the Windows Start menu.
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Main Window

The MassHunter Mass Profiler Software main window has the following areas 
and controls.

• “Menus” (below)

• “Toolbar” on page 10

• “Feature Plot” on page 11

• “Feature Table” on page 15

Menus

The following menu options appear in MassHunter Mass Profiler Software:

File menu

Create New Project Opens the New Project dialog box, which lets you set up a 
new project for use in MassHunter Mass Profiler Software. See “To create a 
project” on page 19.

Open Project Lets you open a project. (*.pjt file). The results from the previous 
analysis are loaded to the Feature Table and Feature Plots. The method used 
to process the project previously is also loaded automatically.

Edit Project Opens the Edit Project dialog box, which lets you edit the current 
project. See “To edit a project” on page 26.

Save Project Saves changes to the current project.

Save Project As Saves the current project under a new name.

Export Feature Summary > From Graphed Data Exports the features highlighted 
in the current plot for use in Excel. The export file format is tab-separated 
value, but it is saved with a .xls extension so that Excel will open automatically 
when you double-click on the file in Windows Explorer.

Export Feature Summary > From Feature Table Exports the feature summary 
information from the Feature Table for use in Excel. The export file format is 
tab-separated value, but it is saved with a .xls extension so that Excel will open 
automatically when you double-click on the file in Windows Explorer. You can 
export All Features, Marked Features, or Unmarked Features.
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Export Targeted MS/MS Inclusion List > From Graphed Data Opens the Export 
Inclusion List Options dialog box, which lets you specify parameters for 
exporting the averaged ion data (m/z and RT of representative ions) for each 
feature that is highlighted in the plot (in .csv format), for use in data 
acquisition in targeted MS/MS experiments. 

Export Targeted MS/MS Inclusion List > From Feature Table Opens the Export 
Inclusion List Options dialog box, which lets you specify parameters for 
exporting the averaged ion data (m/z and RT of representative ions) for each 
feature in the table (in .csv format), for use in data acquisition in targeted 
MS/MS experiments. You can export All Features, Marked Features, or 
Unmarked Features.

Export MPP Input File > From Graphed Data Exports the features currently 
highlighted in the Feature Plot for use in Mass Profiler Professional (.txt 
format).

Export MPP Input File > From Feature Table Exports the feature table for use in 
Mass Profiler Professional (.txt format). You can export either All Features, 
Marked Features, or Unmarked Features.

Export Composite-Compounds CEF > From Graphed Data Exports the features 
currently highlighted in the Feature Plot for use with other programs (.cef 
format).

Export Composite-Compounds CEF > From Feature Table Exports the feature 
table for use with other programs (.cef format). You can export All Features, 
Marked Features, or Unmarked Features. The export file contains a list of 
compounds. Each compound is based on one row of the Feature Table. The 
data from different samples are summed up to form a composite compound. 
This export file format can be used with the Find by Formula feature in 
MassHunter Workstation Qualitative Analysis software or as input to 
standalone ID Browser program.

Exit Closes the MassHunter Mass Profiler Software window and exits the 
program. 
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Method menu

Method parameters define and restrict the features that appear in the Feature 
Plot and Feature Table. 

Open and Apply Method Lets you open a method and automatically process 
the current project with the parameters in the method you open. See “To apply 
a different method” on page 26.

Edit Method Opens the Method Parameters dialog box, which lets you edit the 
current method. Method parameters appear on three tabs: Pre-Analysis 
Filters, Alignment & Normalization, and Result Filters. See “To edit a method” 
on page 21.

Save Method Saves changes to the current method.

Save Method As Saves the current method parameters as a new method.

Reset Method to Default Restores all method parameters to default values.

View menu

Show Corrected Times/Show Raw Times If an RT correction is performed as 
part of the method, then a “corrected time” is calculated for each feature and 
each sample. Selecting Show Corrected Times displays the values of these 
corrected retention times. Selecting Show Raw Times displays the raw 
(original) retention times from the input files (without correction).

Feature Details for Selected Feature Opens the Feature Information window 
for the feature selected in the Feature Table. See “To view feature details” on 
page 31. Not available for data imported from .CSV file.

Abundance Distribution for Selected Feature Displays plots that show the 
distribution of abundance for the samples in the two groups. The abundance 
distribution of each sample for the feature is presented as a histogram and as 
curves that are color-coded for the group. The curves are calculated by using 
the least-squared fit to a Gaussian shape. See “To view the abundance 
distribution graph for a feature” on page 33.

Global Occurrence Histograms Displays histograms that show how frequently 
a feature occurs in samples within each group and across both groups. See “To 
view global occurrence histograms” on page 34.
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Web menu

Performs a mass search for the feature currently selected in the Feature Plot 
or Feature Table and displays the results in your internet browser window. 
You can search the following databases: 

• ChemIDplus

• HMP

• NIST

• PubChem

• Web METLIN

Image menu

Print Image Prints the current Feature Plot image.

Copy Image to Clipboard Copies the current Feature Plot image to the 
Clipboard to paste into other applications as either a Metafile (.emf format) or 
Bitmap (.bmp format).

Save Image to File Saves the current Feature Plot image as either a Metafile 
(.emf format) or Bitmap (.bmp format).
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Identify Features menu

These items do not apply to data imported from .CSV file or LMFE input 
data.

For Highlighted Features on Graph Lets you identify compounds for the 
features highlighted in the selected tab of the Feature Plot, using the Agilent 
MassHunter ID Browser program. Results you save in ID Browser are available 
for review in Mass Profiler when you close the ID Browser window.

For All Features in Table Lets you identify compounds for all features 
displayed in the Feature Table, using the Agilent MassHunter ID Browser 
program. Results you save in ID Browser are available for review in Mass 
Profiler when you close the ID Browser window.

For Marked Features in Table Lets you identify compounds for the features 
marked in the Feature Table, using the Agilent MassHunter ID Browser 
program. Results you save in ID Browser are available for review in Mass 
Profiler when you close the ID Browser window.

For Unmarked Features in Table Lets you identify compounds for the features 
that are unmarked in the Feature Table, using the Agilent MassHunter ID 
Browser program. Results you save in ID Browser are available for review in 
Mass Profiler when you close the ID Browser window.

Quick Lookup for Selected Feature Opens the Agilent MassHunter ID Browser 
program with the feature currently selected in Mass Profiler displayed. In this 
mode, results from ID Browser are not available in Mass Profiler when you 
close the ID Browser window. See “To identify a single feature” on page 36.

See “Identifying Features” on page 36 for more information. 

Help menu

Contents Opens the online help window for MassHunter Mass Profiler 
software with the Contents tab displayed.

About Displays version information for MassHunter Mass Profiler software.
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Toolbar

The following items are available on the MassHunter Mass Profiler Software 
toolbar:

Button Equivalent menu item

 
File > Create New Project

 
File > Open Project

 
File > Save Project

 
Method > Open and Apply Method

 
Method > Edit Method

 
Method > Save Method

 
Identify Features > For All Features in Table
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Feature Plot

This area of the MassHunter Mass Profiler Software window shows the results 
of processing a project with the current method and lets you see differences 
between features in two groups of samples. It displays processed data 
automatically when you create a new project, edit a project, open and apply a 
method, or edit a method. The size of a point on the graph indicates the 
abundance of a feature: the larger the dot, the more abundant the feature.

You can change the plot style and limit the data that appears in the Feature 
Plot using the options described below. See “To view results in the Feature 
Plot” on page 27.

Graph data

Lets you select between displaying all samples or a single sample. This is set 
initially to display All samples. When the Plot style is set to Average Feature, 
the Graph data is always set to All samples, even if you select a single sample.

Plot style

Lets you select the style of plot to display from the following:

Average Feature Uses the group averages as the feature properties (Mass, RT, 
and Abundance).

Colored by feature Plots each distinct feature in a different color. When more 
features exist than can be plotted in different colors, then features in the same 
area of the plot are graphed in different colors.

Colored by sample Plots the features in the same sample in the same color 
(e.g., if there are 10 samples, then there are 10 colors).

Colored by group Two colors, blue and red, represent the features in the two 
groups of samples.
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Visibility criterion

Lets you select one of the following criteria, whose threshold determines 
which features will be highlighted (i.e. appear as solid dots) in the plot. 
Features that don’t meet the threshold value are plotted as dimmed open 
circles.

Max RSD abundance The max of relative standard deviations of the two 
groups, that is, any feature whose max group abundance-RSD is larger than 
the threshold is filtered out (plotted as an open circle).

SD RT Standard deviation for the retention time

SD Mass Standard deviation for the mass

Differential Score Relative score from 0 to 100 that indicates if the difference 
in abundance of a feature in the two groups is significant. Two methods are 
available for calculating the differential score, Student t-test or SVM 
sensitivity, set on the Result Filters tab of the Method Parameters dialog box 
as described in “To perform a differential analysis and set result filters” on 
page 25.

None (the default) No visibility criterion is applied, so all features are 
highlighted.

Visibility threshold

Sets the threshold for the selected Visibility Criterion. Features that don’t 
meet the threshold for the selected Visibility Criterion appear as dimmed open 
circles in the plot.

Feature Plot tabs

The tabs at the top of the Feature Plot let you view different plot types:

Mass vs. RT Plots mass vs. retention time (RT) for each feature.

Log2 Ratio vs. RT Plots the log2 of the ratio of abundance vs. retention time.

• For Average feature plot style, the abundance ratio is average abundance 
for <Group 1> over the average abundance for <Group 2>. 
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• When Graph data is set to a single sample, the abundance ratio is the 
abundance for a single feature over the average abundance of that feature in 
its group.

Log/Log Plot Plots the log2 of the average abundance of a feature: 

• in <Group 1> vs. log2 of its average abundance in <Group 2> for Average 
feature plot style.

• in a single sample vs. the log2 of the average of its group When Graph data 
is set to a single sample.

Unique to <Group 1> Plots Mass vs. RT for those features that are present in 
the first group of samples, but not in the second group of samples.

Unique to <Group 2> Plots Mass vs. RT for those features that are present in 
the second group of samples, but not in the first group of samples.

Expression

Shows only the features that have a larger average abundance in one group as 
follows, or Both, which displays all features in the table.

Up  Shows only features that have a larger average abundance in  
<Group 1> than in <Group 2> (called up-regulated).

Down  Shows only features that have a larger average abundance in  
<Group 2> than in <Group 1> (called down-regulated).

Plot mouse actions

• Zoom—Drag the mouse to define an area of interest. The area expands when 
you release the mouse button.

• Pass the cursor over a feature to view information about that feature.

• Click in the plot to select the feature that is closest to that location and to 
highlight the row in the Feature Table that corresponds to that feature.
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Plot shortcut menu

The following options appear when you right-click anywhere on a plot. Note 
that right-clicking in the plot also changes the selection in the table to the 
nearest data point.

Unzoom Returns the plot to the previous zoom level.

Autoscale Returns the plot to the original display.

Print Image Sends the plot image to a printer.

Copy Image to Clipboard Copies the current plot image to the Clipboard to 
paste into other applications as either a Metafile or Bitmap.

Save Image to File Saves the current plot image in either .emf or .bmp format.

Feature Details Opens the Feature Information window for the feature that is 
closest to that location on the plot.

Abundance Distribution Opens the Single Feature Abundance Distribution 
window, which displays the plots that show the distribution of abundance for 
the samples in the two groups.

Identification Lookup Opens the ID Browser program with the feature 
currently selected in Mass Profiler displayed. In this mode, results from ID 
Browser are not available in Mass Profiler when you close the ID Browser 
window.

Web Performs a mass search for the feature currently selected in the plot 
and displays the results in your internet browser window. You can search the 
following databases: ChemIDplus, HMP, NIST, PubChem, and Web METLIN.
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Feature Table

This area of the MassHunter Mass Profiler Software window shows the results 
of processing a project with the current method. It displays processed data 
automatically when you create a new project, open a project that has been 
processed before, edit a project, open and apply a method, or edit a method. It 
lets you see the primary feature values, including the average values for each 
feature across both groups and then each group separately. The table can be 
sorted by the values in any column by clicking on the column heading of 
interest. Results for Internal standards are displayed in green in the table.

Expression

Shows only the features that have a larger average abundance in one group as 
follows:

Up  Filters the table to show only features that have a larger average 
abundance in <Group 1> than in <Group 2> (called up-regulated).

Down  Filters the table to show only features that have a larger average 
abundance in <Group 2> than in <Group 1> (called down-regulated).

Both  Shows all features in the table.

Feature summary

These values are averages for the feature across all samples.

ID (row number) Feature identification number, assigned based on the values 
in the Abundance column. The table is initially sorted by these values, but the 
sort order can be changed by clicking on the heading of any other column.

RT Average retention time of the feature in all samples

RT SD Standard deviation of the retention time of the feature in all samples

Mass Average mass of the feature in all samples

Mass SD Standard deviation of the average mass of the feature in all samples
Agilent Mass Profiler Software Quick Start Guide 15



Abundance Average abundance of the feature across the samples in both 
groups

RSD Relative standard deviation of the abundance of the feature across the 
samples in both groups

Freq The number of samples in both groups that contain this feature

Mark Click the check box in the Mark cell for a feature of special interest. 
This annotation is exported along with the other data in the table, so that the 
feature can still be distinguished when viewed in other programs. If you select 
a feature in error, click again to clear the mark.

<Group 1>, <Group 2>

The values in these parts of the table are averages for the feature across the 
samples within the individual groups only.

RT Average retention time of the feature within the group

Mass Average mass of the feature within the group

Abundance Abundance of the feature within the group

RSD Relative standard deviation of the abundance of the feature in the group

Freq The number of samples in the group that contain this feature

Comparison

The values in this part of the table are average differences for the feature 
between samples in both groups.

RT The difference in the retention time of the feature between the groups

Mass The difference in the mass of the feature between the groups

log2(A1/A2) The log of the ratio of the average feature abundance for all 
samples in <Group 1> over the feature abundance for all samples in <Group 2>.

Expression The absolute value of the above expression.
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Diff. Score The differential score, which is a number between 0 and 100 that 
represents the relative confidence that the difference in intensity of a feature 
between the two groups is real. Two methods are available for calculating the 
differential score, Student t-test or SVM sensitivity, set on the Result Filters 
tab of the Method Parameters dialog box as described in “To perform a 
differential analysis and set result filters” on page 25.

Feature Table shortcut menu

The following options appear when you right-click in any row number cell on 
the left side of the Feature Table:

Feature Details Displays the Feature Information window for the selected 
feature. Not available for data imported from .CSV file.

Abundance Distribution Opens the Single Feature Abundance Distribution 
window, which displays the plots that show the distribution of abundance for 
the selected feature in the samples in the two groups. 

Identification Lookup Opens the ID Browser program with the feature 
currently selected in Mass Profiler displayed. In this mode, results from ID 
Browser are not available in Mass Profiler when you close the ID Browser 
window. Does not apply to data imported from .CSV file or LMFE input data.

Web Performs a mass search for the feature currently selected in the table 
and displays the results in your internet browser window. You can search the 
following databases: ChemIDplus, HMP, NIST, PubChem, and Web METLIN. 
Does not apply to LMFE input data.
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Getting Started

The following topics will help you get started with Agilent MassHunter Mass 
Profiler Software. This guide and the online help explain these activities.

Processing Data
• “To create a project” on page 19
• “To edit a method” on page 21
• “To filter features” on page 21
• “To align features” on page 23
• “To normalize features” on page 24
• “To perform a differential analysis and set result filters” on page 25
• “To apply a different method” on page 26
• “To edit a project” on page 26

Viewing Results
• “To view results in the Feature Plot” on page 27 
• “To set Feature Plot filters and colors” on page 28
• “To select Feature Plot view” on page 29
• “To view results in the Feature Table” on page 30
• “To view feature details” on page 31
• “To print, save, or copy the Feature Plot image” on page 32
• “To view more information from database websites” on page 32
• “To view the abundance distribution graph for a feature” on page 33
• “To view global occurrence histograms” on page 34

Identifying Features
• “To identify a single feature” on page 36
• “To identify a batch of features” on page 37
• “To identify features with ID Browser” on page 38
• “To review results in the Compound List Window” on page 39

Exporting Mass Profiler Data

• “To mark features for annotation” on page 40 
• “To export data from the Feature Table” on page 40 
• “To export data from the Feature Plot” on page 41
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Processing Data

To process data in MassHunter Mass Profiler Software, samples (.cef files 
output from MassHunter Qualitative Analysis software or your own generic 
.csv files) are first organized into groups in a project. Processing parameters 
are set in methods and the current method is automatically applied to the 
current project (samples). You can edit the method and set various filters for 
the data you want to consider. 

Format for .csv 
files

A generic (.csv) file must begin with a header row (RT, mass, abundance), 
followed by three columns of information for each sample row, for use as Mass 
Profiler input. 

To create a project

Use this procedure to set up a project that contains the samples (.cef files) that 
you want to investigate.
1 Click Create New Project on the File menu, or click the Create New 

Project button on the toolbar.
2 On the New Project dialog box:

a Select the Input data type from one of the following: Small molecules 
(LC), Large molecules, or Generic (csv).

b Type in a Name for the project.

c Specify whether you want 1 or 2 groups in the project.
3 Set up the first group of samples on the left side of the screen as follows:

a Type in a name for the Group, or accept the default name Experiment.

b Click the Samples Add button to open the Select Files dialog box.

c Select the .cef or .csv files to add to the group. Use Shift+click or Ctrl+click 
to select multiple files.

d Click the Open button on the Select Files dialog box. The files you 
selected are listed for the first group on the left side of the New Project 
dialog box.

e Repeat steps a - d to add additional samples if desired, but each file can 
be added to the project only once.

NOTE To remove an unwanted sample from the list, click in the first (blank) column of the sample 
row of interest to select the row, then click the Delete button.
Agilent Mass Profiler Software Quick Start Guide 19



4 If you selected 2 groups for the project in Step 2, set up the second group of 
samples on the right side of the screen as follows:

a Type in a name for the group, or accept the default name Control.

b Click the Samples Add button to open the Select Files dialog box.

c Select the .cef or .csv files to add to the group. Use Shift+click or Ctrl+click 
to select multiple files.

d Click the Open button on the Select Files dialog box. The files you 
selected are listed for the second group on the right side of the New 
Project dialog box.

e Repeat steps a - d to add additional samples if desired, but each file can 
be added to the project only once.

5 (Optional) Enter a value in the Scalar column for a sample to multiply 
feature abundance values by a set amount in that sample.

6 Click OK on the New Project dialog box. The samples are automatically 
processed using the current method and the results are displayed in the 
Feature Plot and Feature Table in the Mass Profiler main window.

7 To obtain different results, apply a different method to the project as 
described on page 26, or change parameters in the current method as 
described in “To edit a method” on page 21.

8 (Optional) To save the changes to the current project, click Save Project on 
the File menu or click the Save Project button on the toolbar.

9 (Optional) To save the project under a new name for later use, click Save 
Project As on the File menu, enter a name for the project (.pjt file), and 
click the Save button on the Save As dialog box.

Projects can be modified later as described in “To edit a project” on page 26.
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To edit a method

Use this procedure to edit method parameters for processing the samples in 
your project. You can save methods for later use.
1 Click Edit Method on the Method menu, or click the Edit Method button on 

the toolbar.
2 Set parameters on the following tabs of the Method Parameters dialog box:

• Pre-Analysis Filters: see “To filter features” below.

• Alignment & Normalization: see “To align features” on page 23 and “To 
normalize features” on page 24

• Result Filters: see “To perform a differential analysis and set result 
filters” on page 25

3 Click OK. The samples in the current project are automatically processed 
using the current method and the results are displayed in the Feature Plot 
and Feature Table in the Mass Profiler main window.

4 (Optional) To save the changes to the current method, click Save Method 
on the Method menu or click the Save Method button on the toolbar.

5 (Optional) To save the method under a new name for later use, click Save 
Method As on the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.

To filter features 

Use the following procedure to set limits on the raw features that are loaded 
into MassHunter Mass Profiler Software from the incoming .cef files, which 
contain all the extracted features from Mass Hunter Qualitative Analysis 
software.

1 Click Edit Method on the Method menu, or click the Edit Method button on 
the toolbar to open the Method Parameters dialog box.

2 Set filter parameters on the Pre-Analysis Filters tab:

Feature position — To filter based on retention time and or mass. The RT 
position filter is ignored for MFE infusion data.

Isotope pattern — To filter based on isotope distribution pattern. This filter 
is ignored for data imported from CSV file and LMFE input data.

Charge state — To filter by charge state. This filter is ignored for data 
imported from CSV file and LMFE input data.
Agilent Mass Profiler Software Quick Start Guide 21



Special masses — To exclude or limit features with certain masses.

Mass defect (Da) — To set a range for the acceptable mass defect. This filter 
is ignored for LMFE input data

Number of ions — A large number of ions detected for a feature usually 
indicates robustness of the feature detection. Specifying a minimum 
Number of ions will filter out features that may be less reliable. This filter 
is ignored for data imported from CSV file and LMFE input data

Neutral losses — You can load features according to the neutral losses they 
have as follows. This filter is ignored for data imported from CSV file and 
LMFE input data.

• Ignored— ignores neutral-loss information and loads all the features 

• Any— loads only features with any neutral losses 

• Specified— lets you type in a list of formulas for neutral losses. In this 
case, only features that have any neutral loss specified in the list are 
loaded. For example, the formulas H2O and H3PO4 may have been 
specified for neutral-loss search in Agilent MassHunter Qualitative 
Analysis Software. So the resulting *.cef files may contain some features 
with H2O neutral loss, some with H3PO4, some with both, and some with 
no neutral losses. 

Abundance — To specify feature abundance parameters.
3 Click OK to initiate the analysis, using the values entered in Step 2 above, 

along with current values from the Alignment & Normalization tab and the 
Result Filters tab.

4 View the results in the Feature Plot and Feature Table, as described in 
“Viewing Results” on page 27.

5 (Optional) To save the changes to the current method, click Save Method 
on the Method menu or click the Save Method button on the toolbar.

6 (Optional) To save the method under a new name for later use, click Save 
Method As on the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To align features 

Use the following procedure to set parameters to adjust for retention time 
shifts in the raw data and correlate features across samples based on mass 
and retention time.

1 Click Edit Method on the Method menu, or click the Edit Method button on 
the toolbar to open the Method Parameters dialog box.

2 Set the following Alignment parameters on the Alignment & 
Normalization tab.

• Mass tolerance (Intercept and Slope)

• RT tolerance For RT correction (Intercept and Slope)

• RT correction method (Without standards, With standards, or None)

• RT tolerance For feature binning (Intercept and Slope)
3 If you selected With standards for the RT correction method in Step 2, set 

the following additional options on the left side of the screen:

a No. of Internal Standards (at least two need to be defined)

b For each internal standard:

• The RT and Mass

• Mark the Algn (alignment) check box to use this standard for retention 
time correction.

• Clear the Norm (normalization) check box, unless you plan to use the 
current standard for normalization as described in “To normalize 
features” below.

4 Click OK to initiate the analysis, using the values entered in Steps 2 and 3 
above, along with current values from the Pre-Analysis Filters tab and the 
Result Filters tab.

5 View the results in the Feature Plot and Feature Table, as described in 
“Viewing Results” on page 27.

6 (Optional) To save the changes to the current method, click Save Method 
on the Method menu or click the Save Method button on the toolbar.

7 (Optional) To save the method under a new name for later use, click Save 
Method As on the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To normalize features 

Use this procedure to normalize abundance values across all the files.

1 Click Edit Method on the Method menu, or click the Edit Method button on 
the toolbar to open the Method Parameters dialog box.

2 Select one of the Normalization options (Without standards or With 
standards) on the right side of the Alignment & Normalization tab.

3 If you selected With standards in Step 2, set the following additional 
options on the left side of the screen:

a No. of Internal Standards (at least two need to be defined)

b For each internal standard:

• The RT and Mass

• Mark the Norm (normalization) check box to use a particular standard 
for normalization.

• Clear the Algn (alignment) check box, unless you plan to use this 
standard for alignment as described in “To align features” on page 23.

4 Click OK to initiate the analysis, using the values entered in Steps 2 and 3 
above, along with current values from the Pre-Analysis Filters tab and the 
Result Filters tab.

5 View the results in the Feature Plot and Feature Table, as described in 
“Viewing Results” on page 27.

6 (Optional) To save the changes to the current method, click Save Method 
on the Method menu or click the Save Method button on the toolbar.

7 (Optional) To save the method under a new name for later use, click Save 
Method As on the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To perform a differential analysis and set result filters

1 Click Edit Method on the Method menu, or click the Edit Method button on 
the toolbar to open the Method Parameters dialog box.

2 Set the following Analysis preferences on the Result Filters tab:

• Missing-info treatment—0 abundance or excluded. Note that you can’t 
select Excluded if you select SVM sensitivity as the Differential scoring 
method.

• Differential scoring—one of the following:

Student t-test–assesses if the abundance distribution for a given feature 
is statistically different between the two groups

SVM sensitivity–measures the degree to which the abundance of a given 
feature contributes to the location and separating power of a hyperplane 
identified in multidimensional feature-abundance space that maximally 
separates the features in two groups (SVM=Support Vector Machine)

3 Set the following Result filters:

• Min |log2 (abund1/abund2)|

• Min differential score

• Expression—Both, Up (up-regulated), or Down (down-regulated)

• Min relative frequency and one of the following options: And unique to 
a single group, in at least one group, in all groups, or of total

• Saturated features—Lets you exclude features that were marked as 
saturated by MassHunter Qualitative Analysis software.

• Max number of features—Unlimited or Most abundant <n> features
4 Click OK to perform the analysis, using the values entered in Steps 2 and 3 

above, along with current values from the Pre-Analysis Filters tab and the 
Alignment & Normalization tab.

5 View the results in the Feature Plot and Feature Table, as described in 
“Viewing Results” on page 27.

6 (Optional) To save the changes to the current method, click Save Method 
on the Method menu or click the Save Method button on the toolbar.

7 (Optional) To save the method under a new name for later use, click Save 
Method As on the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To apply a different method

1 Click Open and Apply Method on the Method menu, or click the Open and 
Apply Method button on the toolbar.

2 Select a method in the Open dialog box and click the Open button.

The parameters in the selected method are applied to the current project 
and the results are displayed in the Feature Plot and Feature Table.

To edit a project

Use this procedure to change the properties of an existing project, such as 
name, group names, sample composition, and sample scalar values.

1 Click Edit Project on the File menu to open the Edit Project dialog box.
2 Make the desired changes to the project, such as:

• Add samples using the Add button

• Delete samples using the Delete button

• Change project name

• Change group names

• Change scalar values for samples

3 Click OK on the Edit Project dialog box. The samples are automatically 
processed using the current method and the results are displayed in the 
Feature Plot and Feature Table in the Mass Profiler main window.

4 (Optional) To save the changes to the current project, click Save Project on 
the File menu or click the Save Project button on the toolbar.

5 (Optional) To save the project under a new name for later use, click Save 
Project As on the File menu, enter a name for the project (.pjt file), and 
click the Save button on the Save As dialog box.

NOTE Note that you can not change the Input data type or the number of groups when you edit a 
project.
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Viewing Results

Results are shown automatically in the Feature Plot and Feature Table areas of 
the MassHunter Mass Profiler Software window when a project is processed 
with the current method parameters. Processing is performed automatically 
after the following activities:

• Creating or editing a project

• Applying a different method

• Editing a method

Results are also shown when you open a project, although no new processing 
is done unless you do one of the above activities

See Also “To view results in the Feature Plot” below
“To view results in the Feature Table” on page 30
“To view feature details” on page 31

To view results in the Feature Plot

A plot of Mass vs Retention Time for each feature, averaged across all the 
samples, is automatically displayed in the Feature Plot (Mass vs. RT tab). 

1 Pass the cursor over a data point (feature) of interest on the plot to display 
a brief description of that feature. Note that the size of a point on the graph 
indicates the abundance of a feature: the larger the dot, the more abundant 
the feature.

2 Zoom in by dragging the mouse around the area of interest. The area is 
expanded when you release the mouse button.

3 You can change how features are displayed in the Feature Plot as described 
in “To set Feature Plot filters and colors” on page 28.

4 Click on a different tab above the graph to view a different plot, as 
described in “To select Feature Plot view” on page 29.

5 Click on a data point in the plot to highlight the corresponding row for that 
feature in the Feature Table. See “To view results in the Feature Table” on 
page 30.

6 Right-click in the plot to access the shortcut menu options described on 
page 14.

See Also “To view feature details” on page 31
“To print, save, or copy the Feature Plot image” on page 32
“To export data from the Feature Plot” on page 41
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To set Feature Plot filters and colors

Use the following procedure to limit the features that are shown in the plot 
and to use color to identify features individually, by sample, or by group. These 
steps can be selected in any order. The plot settings are as follows when the 
results are first displayed after processing:

• Graph data = All samples

• Plot style = Average feature, which shows data points in black, 
representing the average mass and RT of features across all samples)

• Visibility criterion = None (highlights all features)

• Expression = Both (shows both up- and down-regulated features)

1 To see the feature data from a single sample only, select the sample name 
(input file name) of interest from the Graph data list. Note that when Plot 
style is set as Average feature, you may select a single sample but the plot 
still shows the Average feature (averaged cross all samples).

2 To set a different Plot style, select one of the following settings, which 
changes the color of the data points to distinguish features in various ways:

• Colored by feature—To distinguish each feature with a different color. 
The data points for the same feature in each sample appear (no longer 
averaged across all samples). For example, if a feature is present in all 
ten samples, the black data point for an average feature becomes ten 
green data points (because of slightly different RTs). The system has a 
limit of 10 colors, so the same color will be used for multiple features if 
you have more than 10 features.

• Colored by sample—To distinguish features in the same sample. All 
features in the same sample appear in the same color. So if there are ten 
samples, then data points appear in ten colors. The system has a limit of 
10 colors, so the same color will be used for multiple samples if you have 
more than 10 samples.

• Colored by group—To distinguish features in a group. (Red for features 
in <Group 1>, Blue for features in <Group 2>).

3 To filter features using a visibility criterion and threshold:

a Select one of the following from the Visibility criterion list: Max RSD 
abundance, SD RT, SD Mass, or Differential Score.

b Adjust the Visibility threshold to the desired level.
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4 To show only features that have a larger average abundance in one group:

a Select Up for Expression (below the Feature Plot) to plot only features 
that have a larger average abundance in <Group 1> than in <Group 2> 
(called up-regulated).

b Select Down for Expression (below the Feature Plot) to plot only 
features that have a larger average abundance in <Group 2> than in 
<Group 1> (called down-regulated).

To select Feature Plot view

Use this procedure to select a different plot view for the results of analysis in 
the Feature Plot. The Mass vs. RT plot is presented by default when samples 
are analyzed. These steps can be done in any order.

1 Click the Log2 Ratio vs RT tab to view a plot of the log2(A1/A2) value for a 
feature versus the retention time. 

• For Average feature plot style, A1 is the abundance of <Group 1> and A2 
is the abundance of <Group 2>. 

• When Graph data is set to a single sample, A1 is the abundance of the 
sample and A2 is the averaged abundance of the group to which the 
sample belongs.

2 Click the Log/Log Plot tab to view a plot of the log2 of the average 
abundance of a feature:

• in <Group 1> vs log2 of its average abundance in <Group 2> for Average 
feature plot style

• When Graph data is set to a single sample, the plot shows the log2 
abundance of a sample versus the log2 averaged abundance of the 
feature cross the group to which the sample belongs.

3 Click the Unique to <Group 1> tab to plot only those features that are 
present in the first group of samples, but not in the second.

4 Click the Unique to <Group 2> tab to view a plot of only those features that 
are present in the second group of samples, but not in the first.

5 Click the Mass vs. RT tab to view the original plot, i.e. mass vs. retention 
time (RT) for each feature.
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To view results in the Feature Table

The Feature Table contains average values and standard deviations for each 
feature across all samples (Feature summary) and each group separately, 
including retention time (RT), Mass, Abundance, Freq (frequency), SD 
(standard deviation) for RT and Mass, and RSD (relative standard deviation) 
for Abundance values.

Other columns are added to the table to show the results of feature 
identification from the ID Browser program. See “Identifying Features” on 
page 36 for more information.

1 If not already visible, scroll horizontally to view Comparison data on the 
right of the table. Green values are internal standards, if used.

2 To show only the features that have a larger average abundance in one 
group:

a Select Up for Expression (above the Feature Table) to show only 
up-regulated features.

b Select Down for Expression (above the Feature Table) to show only 
down-regulated features.

3 By default, the table is ordered from the highest average Abundance value 
to the lowest. Click on a different column heading to sort the table by the 
values in that column, such as Mass or RT.

4 Right-click in any row number cell on the left side of the Feature Table to 
access the shortcut menu options, such as Feature Details, Abundance 
Distribution, Identification Lookup, and Web search. See page 17 for more 
information.

5 To copy the contents of the table for use in another program, drag the 
mouse to select the cells of interest, then press the C key while holding the 
Ctrl key down. The copied contents can then be pasted into other 
applications, such as Microsoft Excel. 

See Also “To view feature details” on the next page
“To export data from the Feature Table” on page 40
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To view feature details

Use this procedure to view more information about a selected feature. This 
procedure is not available for data imported from .CSV file.

1 Open the Feature Information window for a selected feature in any of the 
following ways:

From the Feature 
Table

• Click to select the feature of interest in the Feature Table, then click 
Feature Details for Selected Feature on the View menu, or 

• Right-click the row number for the feature in the Feature Table, and 
select Feature Details from the shortcut menu.

From the Feature 
Plot

• Right-click on the feature of interest in the Feature Plot, and select 
Feature Details from the shortcut menu. 

2 Review the information for the feature in all the samples in the All samples 
table in the top left area of the screen, such as File ID number, File name, 
RT, Mass, and Abundance. Samples in <Group 1> appear in red; samples in 
<Group 2> appear in blue. Click on a column heading to sort the table by the 
values in that column, such as Abundance or Mass. Note the selected 
feature may not be present in every sample in the project.

3 Click to select a row (sample) in the All samples table and view the 
information for the feature in the selected sample, such as Species, RT, 
m/z, Mass, Abundance, and Width that is displayed in the Selected sample 
table below the All samples table. The columns of information that are 
displayed depend on the input data type of the selected sample.

4 On the right side of the screen, view the feature’s species cluster plots for 
each sample. Zoom in by dragging the mouse around the area of interest. 
The area is expanded when you release the mouse button. 

5 Right-click on a species cluster plot to access the following options:

• Unzoom– Returns the plot to the previous zoom level.

• Autoscale– Returns the plot to the original display.

• Print Image– Sends the image to a printer.

• Copy Image to Clipboard– Copies the current image to the Clipboard to 
paste into other applications as either a Metafile or Bitmap.

• Save Image to File– Saves the current image as either a Metafile (.emf 
format) or Bitmap (.bmp format).
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To print, save, or copy the Feature Plot image

1 Click the appropriate item on the Image menu:

• Print Image

• Copy Image to Clipboard

• Save Image to File
2 If you selected either Copy Image to Clipboard or Save Image to File, 

select the file format (either Metafile or Bitmap).

Alternate method These same menu options are available by right-clicking in the Feature Plot.

To view more information from database websites

Use this procedure to access more information about selected features in any 
of the following online databases: ChemIDplus, HMP, NIST, PubChem, or Web 
METLIN.

From the 
Feature Table

Method 1:

1 Click to select the feature of interest in the Feature Table.
2 Select which database to search from the Web menu.

Method 2:

1 Right-click on the row number for the feature of interest in the Feature 
Table to display the shortcut menu.

2 Select which database to search from the Web submenu.

From the 
Feature Plot

Method 1:

1 Click to select the feature of interest in the Feature Plot. (Note that the 
selected feature is highlighted in the Feature Table.)

2 Select which database to search from the Web menu.

Method 2:

1 Right-click on or near the feature of interest in the Feature Plot to display 
the shortcut menu.

2 Select which database to search from the Web submenu.

In each case above, a mass search is performed for the selected feature in the 
selected database and the results are displayed in your internet browser 
window.
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To view the abundance distribution graph for a feature

1 Open the Abundance Distribution window for a selected feature in any of 
the following ways:

From the 
Feature Table

• Click to select the feature of interest in the Feature Table, then click 
Abundance Distribution for Selected Feature on the View menu, or 

• Right-click the row number for the feature in the Feature Table, and 
select Abundance Distribution from the shortcut menu.

From the 
Feature Plot

• Right-click on the feature of interest in the Feature Plot, and select 
Abundance Distribution from the shortcut menu. 

2 Review the data presented in the Abundance Distribution window, which is 
presented as both a histogram and as curves color-coded by group (red for 
<Group 1> and blue for <Group 2>), as shown in the following example.

The lower plot is a histogram, with Abundance values on the x-axis. The 
height of the bars are determined by the number of samples whose 
abundance falls into that abundance bin. 

The upper plot has the same x-axis. The distribution curves are calculated 
using the least-squared fit to a Gaussian shape of the bars in the lower plot.
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To view global occurrence histograms

Use this procedure to view global occurrence histograms, which show the 
relationship between the number of features and the number of samples.

1 Click Global Occurrence Histograms on the View menu.
2 Review the information presented in the Global Occurrence Histograms 

window, which displays a histogram for each group and a combined 
histogram of both groups. Each histogram shows the frequency of feature 
occurrence in the samples within a group or within both groups. The x-axis 
is the number of samples that a particular feature occurs in (i.e. 0, 1, 2, 3, 4, 
up to the number of samples in the group). The y-axis is the number of 
features that occur in that number of samples (i.e. from 0 up to the number 
of features in the project). 

Example Global Occurrence Histograms window: 

The center histogram (Control 1 group) in the example above shows that:

• ~20 features do not occur in any sample in this group.
• ~10 features occur in 1 sample in this group.
• ~22 features occur in 2 samples in this group.
• ~25 features occur in 3 samples in this group.
•  50 features occur in 4 samples in this group.
• ~270 features occur in all 5 samples in this group.
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The histogram on the right (Combined group) shows that:

• Every feature occurs in at least 5 samples in the project.
• ~21 features occur in 5 of 15 samples in the project.
• ~9 features occur in 6 of 15 samples in the project.
• ~6 features occur in 7 of 15 samples in the project.
• ~7 features occur in 8 of 15 samples in the project.
• ~10 features occur in 9 of 15 samples in the project.
• ~26 features occur in 10 of 15 samples in the project.
• ~17 features occur in 11 of 15 samples in the project.
• ~33 features occur in 12 of 15 samples in the project.
• ~33 features occur in 13 of 15 samples in the project.
• ~68 features occur in 14 of 15 samples in the project.
• ~152 features occur in all 15 samples in the project.
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Identifying Features

The following activities allow you to identify features using the MassHunter ID 
Browser program. These procedures are not available for data imported 
from .CSV file or LMFE input data.

• “To identify a single feature” on page 36

• “To identify a batch of features” on page 37

• “To identify features with ID Browser” on page 38

• “To review results in the Compound List Window” on page 39

To identify a single feature

This procedure is not available for data imported from .CSV file or LMFE 
input data.

1 Select the feature of interest and initiate the search in any of the following 
ways:

a From the Feature Table:

• Click to select a row (feature) in the Feature Table, then click Quick 
Lookup for Selected Feature on the Identify Features menu.

• Right-click the row number for the feature of interest in the Feature 
Table, then select Identification Lookup from the shortcut menu.

b From the Feature Plot:

• Right-click on or near the feature of interest on the Feature Plot, then 
select Identification Lookup from the shortcut menu. 

2 Identify features with ID Browser as described on page 38. The 
identification methods available are Database search (CSV, PCD/METLIN) 
and MFG (molecular formula generation). Spectral library search is not 
currently supported in ID Browser for LC/MS data.

3 Review results in the Compound List Window as described on page 39.
4 Click the Save and Return button to close the ID Browser window and 

return to Mass Profiler.

Results of identification lookup for a single feature are not available when 
you return to Mass Profiler.
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To identify a batch of features

This procedure is not available for data imported from .CSV file or LMFE 
input data.

1 Select the features and initiate the search in any of the following ways:

a From the Feature Table:
• To identify the features currently displayed in the Feature Table, click 

For All Features in Table on the Identify Features menu or click the 
Identify All Features in Table button on the toolbar.

• To identify only the marked features in the Feature Table, click For 
Marked Features in Table on the Identify Features menu.

• To identify only the unmarked features in the Feature Table, click For 
Unmarked Features in Table on the Identify Features menu.

b From the Feature Plot:

• Click For Highlighted Features on Graph on the Identify Features 
menu.

2 Identify features with ID Browser as described on page 38. The 
identification methods available are Database search (CSV, PCD/METLIN) 
and MFG (molecular formula generation). Spectral library search is not 
currently supported in ID Browser for LC/MS data.

3 Review results in the Compound List Window as described on page 39.
4 Click the Save and Return button to close the ID Browser window and 

return to Mass Profiler.
5 Review the search results in the Feature Table as described on page 30.
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To identify features with ID Browser

This procedure is not available for data imported from .CSV file or LMFE 
input data.

1 Click one of the following items on the Identify Features menu in Mass 
Profiler.

• For Highlighted Features on Graph

• For All Features in Table

• For Marked Features in Table

• For Unmarked Features in Table

• Quick Lookup for Selected Feature

The Agilent MassHunter ID Browser window opens with the Compound 
Identification Wizard dialog box displayed.

2 Mark one or more of the methods to use to identify compounds:

• Database search (CSV, PCD/METLIN)

• MFG (molecular formula generator)

3 If you marked the MFG check box in Step 2, select whether to generate 
formulas for all compounds or only for compounds that have not been 
identified yet.

4 Click the Next >> button. The Compound Identification Wizard 
Identification Method dialog box opens.

5 You can optionally perform the following steps to open a different method 
or change method parameters. 

• Load a new method.

• Modify the method parameters.

• Save the method.
6 Click the Finish button to start the identification process. 
7 Review the results in the Compound List window as described on the 

following page.

NOTE Spectral library searching for LC/MS compounds is not supported in this release.
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To review results in the Compound List Window

This topic tells how to view compound results in the Compound List Window 
of the ID Browser. 

1 View the compounds in the table in the Compound List Window. 

• Each row in the table shows a different compound. 

• Each column describes a different piece of information about each 
compound. For a list of the information that can be displayed for a 
compound, see the ID Browser online help.

2 Click the + button to the left of a compound to display the second level of 
the compound table for the selected compound.

• The second level of the table shows a merged identification list that 
contains results from Generating Formulas and from Database and 
Library Search. 

• Second level rows have a green background.
3 Click the + button next to a second level search result to display the third 

level of the compound table for the selected result.

• The third level of the table shows the species information, if the second 
level has a formula assigned from either generate formulas or database 
search. 

• Third level rows have a white background.
4 Click the + button next to an entry in the third level of the table to display 

the fourth level of the compound table.

• The fourth level of this table shows the peak list. The peak list will show 
the best hit information even when the highlight changes.

• Fourth level rows have a blue background.
5 Click the - button to close a level that is open. Closing a compound row 

automatically closes the 2nd, 3rd and 4th level rows for that compound. 

There is no limit to how many levels can be open for as many compounds as 
you want at the same time.
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Exporting Mass Profiler Data

This section describes how to export data from MassHunter Mass Profiler 
software for use with other programs, such as Excel and GeneSpring MS.

• “To mark features for annotation” below

• “To export data from the Feature Table” below

• “To export data from the Feature Plot” on page 41

To mark features for annotation

Use this procedure to mark any features of special interest. These marks will 
be included when you export data from the Feature Table or the Feature Plot.

• Click in the column labeled Mark in the rows for the features of interest in 
the Feature Table.

• To deselect a feature that is currently marked, click again in the column 
labeled Mark in the row for the feature you want to clear.

To export data from the Feature Table

1 (Optional) Mark any features that are of special interest as described in “To 
mark features for annotation” above.

2 Click one of the following items on the File menu, depending on the format 
you want to use to export the data:

• Export Feature Summary > From Feature Table to export summary 
data for use in Excel.

• Export Targeted MS/MS Inclusion List > From Feature Table to 
export inclusion ion list for targeted MS/MS experiment.

• Export MPP Input File > From Feature Table to export feature data for 
use in Mass Profiler Professional.

• Export Composite-Compounds CEF > From Feature Table to export 
feature data for use with other programs.

For each of the above options, you can select whether to export data for All 
Features, Marked Features, or Unmarked Features.
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3 If you selected Export Targeted MS/MS Inclusion List > From Feature 
Table in Step 2, the Export Inclusion List Options dialog box appears. Set 
the following parameters for selecting representative ions for each feature.

a Mark Most abundant to use the most abundant ion for each feature.

b Enter an RT tolerance in minutes or accept the default value of 0.10 
minutes. This parameter is included in the file for use by data acquisition 
software. 

c Click OK.

4 Enter a location and name for the output file and click the Save button.

To export data from the Feature Plot

1 Display the features of interest in the Feature Plot as described in “To set 
Feature Plot filters and colors” on page 28 and “To select Feature Plot view” 
on page 29. Keep the following caveats in mind:

• When you export graphed features, only the features shown as solid dots 
are exported. Circles are filled or not based on the current Visibility 
criterion. If the Visibility criterion is set to None, then the result is 
equivalent to the table-based reports (for Mass vs. RT and Log2 Ratio vs. 
RT plots).

• The ratio and comparison plots can only include features that are 
present in both groups. You may get a different list of features depending 
on which graph you are exporting. The generated files include 
annotations to document what graph and visibility criterion were used 
to generate the export.

• The supported export formats are based on data averaged over one or 
more groups. Even if you choose a Plot style that displays individual per 
sample features, the export will still report the averaged feature data.

2 Click one of the following items on the File menu, depending on the format 
you want to use to export the data:

• Export Feature Summary > From Graphed Data to export summary 
data for use in Excel.

• Export Targeted MS/MS Inclusion List > From Graphed Data to 
export an inclusion ion list for targeted MS/MS experiment.

NOTE For a description of other parameters on this dialog box, see the Export Inclusion List 
Options Dialog Box topic in online help.
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• Export MPP Input File > From Graphed Data to export feature data for 
use in Mass Profiler Professional.

• Export Composite-Compounds CEF > From Graphed Data to export 
feature data for use with other programs.

3 If you selected Export Inclusion List > From Graphed Data in Step 2, the 
Export Inclusion List Options dialog box appears. Set the following 
parameters for selecting ions for the inclusion list.

a Mark Most abundant to use the most abundant ions.

b Enter an RT tolerance in minutes or accept the default value of 0.10 
minutes. This parameter is included in the file for use by data acquisition 
software.

c Click OK.

4 Enter a location and name for the output file and click the Save button.

NOTE For a description of other parameters on this dialog box, see the Export Inclusion List 
Options Dialog Box topic in online help.
42 Agilent Mass Profiler Software Quick Start Guide



Agilent Mass Profiler Software Quick Start Guide 43



Agilent Technologies

© Agilent Technologies, Inc. 2011

Printed in USA 
Revision A, February 2011

*G3297-90007*
G3297-90007

www.agilent.com

In this guide

This Quick Start Guide 
describes how to install and 
use MassHunter Mass Profiler 
Software.

This guide is valid for the 
B.03.00 SP1 revision or higher 
of MassHunter Mass Profiler 
Software, until superseded.

Microsoft®, Windows®, 
Windows 7®, and Excel® are 
registered trademarks of 
Microsoft Corporation in the 
US and/or other countries.


	Agilent MassHunter Mass Profiler Software
	Where to find more information
	What is MassHunter Mass Profiler software?
	What’s New in Version B.03.00 SP1?

	Installation
	Startup

	Main Window
	Menus
	Toolbar
	Feature Plot
	Feature Table

	Getting Started
	Processing Data
	To create a project
	To edit a method
	To filter features
	To align features
	To normalize features
	To perform a differential analysis and set result filters
	To apply a different method
	To edit a project

	Viewing Results
	To view results in the Feature Plot
	To set Feature Plot filters and colors
	To select Feature Plot view
	To view results in the Feature Table
	To view feature details
	To print, save, or copy the Feature Plot image
	To view more information from database websites
	To view the abundance distribution graph for a feature
	To view global occurrence histograms

	Identifying Features
	To identify a single feature
	To identify a batch of features
	To identify features with ID Browser
	To review results in the Compound List Window

	Exporting Mass Profiler Data
	To mark features for annotation
	To export data from the Feature Table
	To export data from the Feature Plot



